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2 AXIS T B eeeeeeeeeee et e e e et et et e et et et eeteeut et eateateateeteateate et ateateeteeutetenteate et eatenteeee et eanentennes 3
2.1 AXiS NEUION/AXIS NEUION PIO TR B oveeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeseseeeeseseseeessesesseneneeseeseseneesenes 3
2.2 AXIS STUTIO T B e eveeeeeeeeeeeeeeeeeeeeeeeeeseeaseeesseaseeaseeasseassaaseesseessseaseeaseenssenseenseenseesseesseenseees 5
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3.2 5N SKEIETAI IIESH .ttt e et e et e e e et eaeeee e et ereeaeseeneeneeeeeeeneens 7
3.3 BUEEBEI T B oottt sttt 9
3 BT AT T oottt ettt e et ettt et en e en e eneeneean 11
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A1 BEBTFEIRERTAHIIE ..ot 22

5.4EARAE T-pose BEAYZIE FL T ] .o.veveverererereeeeeeeeeee s sseeaeseaeaesesese st se et s ese s snaeas 23



NOITOM’

1./

Axis R IVERAEAAL S RE T B AR 5l $8 25080 40 SCRFEH It STt HS 21 28 = 07 3 A A Bk 3l
5 =TT AT A AR

Axis FRAFAE R IR 55 i st X 28 A 226 B BOKE S A H B0 S IR 45 7% 7 o 3 A S 1Sk 22
AN anRiEid PerceptionNeuronPlugin Fif R AR Axis B A% R I Bl /R Fl 4 £ 8 5k
I A& 44 UE4.,
1.1 ThAk

o T¥ErF| UE44.26.0 A

o SCHFFIRENVIMH LA A-pose TR

o SCHFHENTIALFEI bvh BRI

1.2 AXEE
o HEMFLBE U BB B B A R [ Plugins SO
1.3 kT

1. HFHIFET G Wined
2. 3R UE4 A 4.26.0
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2.Axis B E

2.1 Axis Neuron/Axis Neuron Pro W&
1. Ja3h Axis Neuron/Axis Neuron Pro 44
2. ¥T7F File >Settings >Broadcasting

Eile .l ‘indow

Ipen File...
Open Directory...
Recent File

Recent Directory

Settings 5

Tep/Hdp
TCE
Data Server

Advanced BYH

Enable

yooL

Enable

Caleulation

Enable

4. EFALA UL
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TepAdp

ICF

Advanced BVH

Enable

Enable ServerPort: ool

Use

Advanced EVH

Enable

Se ort: Too1

ClientFort: o0z

5.

JH—+ =0

N CharnD

Contact Editing
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2.2 Axis Studio W&
1. Jazh Axis Studio FFFFF— A K LFE
2. IR ESLHE Menu >Settings

VE W R AR AR B SR i Ok Editing ST A A 6 8Os R BN BVH-Edit, Wk
Capturing %4 it 1% 4% 87 JT) BVH-Capture, 58 B4 B 5 S itz (e 1.
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Displacement

Use old header format

) UDP 1

4,
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3.Unreal Engine4 % &.

3.1 %%% Perception Neuron fdiff
1. F#i%E#:: https://shopcdn.noitom.com.cn/article/10.html

2. f#IE PN425_7365868 zip (13| 4.25 5] %4205 H 3 F i Plugins SC e

» software #| UE_4.25 » Engine » Plugins

Mame
Importers

Lumin

Media
MeshPainting
Messaging
MovieScene
MetcodellnitTest
Online
Performance
PM425_7365868
Portal

3. LiE4TJFJ5E Edit>Plugins H7fii\ Perception Neuron #fift /2 75 CL 4 R Ih Ik 4k T
Enable R%
3.2 § A\ Skeletal Mesh
1. 7£ Content Browser TI#R #5057 [Import] $%4.

e AddiNew'~" | L. Import Save All &

- - =
!

2. SIREM fox B U HE.

o Import X
« . 4 s admin » Documents > NoitornAvatar v @& | Search NoitomAvatar P
Organize » Mew folder = - '} o
~
< Downloads A" Name Date modified Type
[ Documents * [&] PN Avatar NewModel v2020.fbx 5/15/2020 12:15 PM 3D Object
&=/ Pictures »
shary -
BVH
v < >
File name: | PN Avatar NewModel v?.O?.O.fbe v ‘ All Files (*.3g2:*.3gp;".3gpp:™.3¢ ~

- Cancel

3. mii [Open]) #Z4I A4S TY S N3 TFE .
4. TFESNEBIMIEMER LS Skeletal Mesh , Skeleton TJLLE K%, 5l RES
N HIBER ) sh @ —ANF 44 B, oAt i B AR SEPR 75 SR AT 3 A
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X

Reset to Default

FBX Import Options

None

4 Animation
Import Anim:

Animation Length

4 Transform

b Import Tr. o x00 ofveo  ofzoo o

D iy x00 ofvoe ofzoo o

4 Material
Search Lo
.

.

5. miii Umport] 2t [import All] #Z41#AT SN
1L FBX Import Options o

Imy h Reset to Default

Current Asset:

4 Mesh

Geometry and Skinning Weights. =

None.

€0

4 Animation

4 Transform

[ Import Tr. 0 X 0.0 wlvoo ofzoo o

X 0.0 wlvoo oJzoo o

4 Material

Create New Materials ¥

Fe SCRYsEEIME FH o FAR R R 4tk . https://shopcdn.noitom.com.cn/article/10.html
6. WMRESAMIISW FE AR, (£ Content Browse [tk 1 &S A IR

rowser

i AddNew~ L. Import Save All ¢ & Content »

' . . ‘
e -+ o+ +* o+
|

M_Baod M_Body_Dark M_FaceMask M_Logo
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3.3 QI Bl i &
1. &+ Skeletal Mesh fbn A7 8012 3hiHE ¥ & Create > Amin Assets > Amin Blueprint.

REZICER N Scarch Content

M_Body M_Body_Dark M_FaceMask

2. R SR ES HiR “Skeletal Mesh” Bt = #E[R]— SOk, ] HEAT 24 PR

Y Filters v 8

3. FEZ N BRA T B i 44 2 “PNSAnimBlueprint”.

4. XHFTIFRIRIGIEE (1 3l i 3 1.
5. AnimGraph 9 bR 44 )4 NewPoseCalc i i, 285 34423 Output pose ¥ A.

" Final Animation Pose

l NewPoseCalc ]

6. siili “NewPoseCalc” i, mii/a AT FEAMINR, i Bone Map A [¥)/M i 3k i
TR EE IR, /214 —#08 PN BIFRHEE B S13E, A1 — 2 BRIRIR A ET- S AR
BRI E ARSI, i B SR P TR /N SR 6 O e A L E ).
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—

4 Skeletons Retargeting

Noitem_Hips

Noitom_RightUpLeg
Noitom_RightLeg
Noitom_RightFoot
Noitom_RightFoot_En v
Noitom_LeftUpLeg
Noitom_LeftLeg
Noitom_LeftFoot

Noitom_LeftFoot_End «

Delete

Duplicate

Cnine 3 - | Snina%

PerceptionNeuron i L IFRHEEHE LA 59 tREHE, HATAMTFH 50T B Fis:

The skeleton setup we use consist of the following 59 bones:

Axis Studio:

Axis Neuron: 1. Hips 31 RightHandRing2
1 Hips 31, RightHandRing2 2. RightUpLeg 32.  RightHandRing3
2 RightUpLeg 32.  RightHandRing3 3. Rightleg 33, RightinHandPinky
3 RightLeg 33.  RightinHandPinky 4. RightFoot 34.  RightHandPinkyl
4, RightFoot 34.  RightHandPinkyl 5. LeftUpLeg 35, RightHandPinky2
5. LeftUpLeg 35.  RightHandPinky2 6. Leftleg 36.  RightHandPinky3
6 Leftleg 36.  RightHandPinky3 7. LeftFoot 37.  LeftShoulder
7 LeftFoot 37. LeftShoulder 8. Spine 38. Leftarm
8 Spine 38.  LeftArm 9. Spinel 39.  LeftForeArm
9. Spinel 39.  LeftForeArm 10.  Spine2 40.  LeftHand
10.  spinez 40.  LeftHand 11, Neck 41, LeftHandThumb1
11.  Spine3 41.  LeftHandThumbl 12, Neckl 42, LeftHandThumb2
12, Neck 42, LeftHandThumb2 13, Head 43, LeftHandThumb3
13.  Head 43.  LeftHandThumb3
14, Rightshoulder 44, LeftinHandindex 1: El‘::irn‘:umer ::: t:ff::l::;:;ltx
5. Rightarm 5. Lefthandindexl 16.  RightForeArm 46, LeftHandindex2
16.  RightForeArm 46.  LeftHandindex2 17, RightHand 47, LeftHandindex3
17 RightHand 47. Lefthandindex3 18.  RightHandThumbl 48.  LeftinHandMiddle
18.  RightHandThumbl 48.  LeftinHandMiddle 15, RightHandThumba 45 LeftHandMiddlel
15. RightHandThumb2 49, LefthandMiddlel 20.  RightHandThumba 50.  LeftHandMiddle2
20 RightandThumb3 50, Leftriandmiddle2 21, RightinHandindex 51, LeftHandMiddle3
21.  RightinHandindex 51.  LeftHandMiddle3

N 22. RightHandIndex1 52. LeftinHandRing
22. RightHandindex1 52. LeftinHandRing 23 RightHandindex2 53, LeftHandRingl
23.  RightHandindex2 53.  LeftHandRingl
24, RightHandindex3 sa. LeftHandRing2 24, RightHandindex3 54, LeftHandRing2
25.  RightinHandMiddle 55, LeftHandRing3 25.  RightinHandMiddle 55, leftHandRing3
26.  RightHandMiddlel 56.  LeftinHandPinky 26.  RightHandMiddlel 56.  LeftinHandPinky
27.  RightHandMiddle2 57.  LeftHandPinkyl 27.  RightHandMiddle2 57.  LeftHandPinkyl
28.  RightHandMiddle3 58.  LeftHandPinky2 28.  RightHandMiddle3 58.  LeftHandPinky2
29.  RightinHandRing 59.  LeftHandPinky3 28.  RightinHandRing 58, LeftHandpinky3
30.  RightHandRingl 30.  RightHandRingl

7. sidi [Compile] #1 [savel #%40.
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NOITOM
3.4 QA EIERE
1. Content Browser T+ 5.7 [ Add New] #40

== Content Bro

e AddNew'~ X Import Save All & = | &= Content »

PE Search Patl OIERREEICERS <carch Content

2. Aiii"Blueprint Class®.

tent Pack...

3. E&EFActor”

AU Pick Parent Class

4 Common C

A or is an object that can be placed or spawned in the
A Pay tor that can be ed' and receive
the ability to
A : E n acto 0 e for controlling a
L“' < it that can be

Al

Y Filters v

M_Body M_Body_Dark M_FaceMask NewBluepri PNSAnimBlueprint

4. HEZRPIFERATEEEM SN “PNActor”.
5. X PNSActot T K4k 2%,
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REZICR A carch Content

M_Body M_Body_Dark M_FaceMask  PNSActor PNSAnimBlueprint

6. i [Add Component] ¥/l PerceptionNeuron P %

® 'FliSkotor & Proje
File  Edit t  View Debug Window

-2- Components

4 Add Component !

peroepton Newon € X
f tionM .

®% Perception Neuron| 3

7. i [Add Component] ¥l SkeletalMesh 4%

1,[ & FNEACton: - & Projer
File  Edit C View Debug  Window

o omponents

4 Add Component 1
Ccleaities © X

% Skeletal Mesh

R
v Skeletal Mesh | 3

8. ik SkeletalMesh 7& 414N H 1% & Animation Class and Skeletal Mesh J&
%, N EFR:
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P RGEComponents.
L

4Transform

-y Bl

A ) < -

[PNSAnimBlueprint_C O &

Event Dispatchers

1LBody ark
€0

Debug  Window Help

:
+ Add Component T [ . ; o Find  Hid
® PNSActor(self)

m= Event Graph
4@ DefaultSceneRoot

95 G GO0 AID CED €D

LA ceptionNeuron

M My Blueprint

Graphs
== EventGraph
© Event BeginPlay
© Event ActorBeginOverlap

3.5 28 E IR S I IK ) A £

Perception Neuron Manager: F>i 15 B X 25 £ 170 42 A0 34 s i i b

Perception Neuron Spawner: H R E SR I M GO JEME . BEZELL A OES s
UL GIDA

1. fE Place Actors [tk (Bi#t/A b E )% perception Neuron Manager #
Perception Neuron Spawner.

File Edit Window Help

. Perception Neur

. Perception Neur;

2. ¥R bR 2B perception Neuron Manager fil Perception Neuron Spawner i i 5]
Y.
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@

\\* hhdlis

Cinema 5
Label

rrent  Source

® e
® e e
Ll Floor

4 Add|Component - of Blueprint/Add Script

Search Components O
Ifti Floor(instance) I

Err— ] o -

4 Transform

[N PerceptionNeuronManager1

+ Add Component~ < Blueprint/Add Script

Search Components
() PerceptionNeuronManagerl (Instance)

- o e

Search Details O EO'

PRICLE L

0.0.0.0

4. UDP #hilliX &

4 Network
® UDP
2 0.0.0.0

Perception Neuron Plugin for UE4
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#dvenced BVH

Enable
4 Network
0.0.0.0

Enable
ClientPort

5. TCP Whili%E
4 Network
0.0.0.0

IP
Port o0 | o]
B -

192.168.12.100 bl

BVH
4 Network
0.0.0.0

Enable
B -

Too1 -
e P 192.168.12.100 a

R G 58 A Avatar Name

ww

6. £ World Outliner [fifi ikt PerceptionNeuronSpawner ,
Al Dynamic Actor Class JEtE% &, Wi~ Efixs:

Perception Neuron Plugin for UE4
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DirectionalLight
nMeuronManaaer] PerceptionNeuronManag

a8 P
. ' PerceptionNeuronSpawnerl PerceptionNeuronSpawng
art Pl rotart

9 acto sele @ View Options~
@) Details

. (8
4 Add|Component = & Blueprint/Add Script

Search Components
(_ PerceptionMeuronSpawner] (Instance)

% RootCompanent (Inherited)

Search Details D E o~

4 Activation

4 Cooking

Is Editor €

4 Actor Binding

atar Name

REZUCER N Sezch Content

4 Actor Binding

I 1 ‘ Input the character

PNSActor [ A from Axis

2 Select PNSActor

b Replication

R

e Avater Name H T-#5iH Actor {3 F ¥ 28 $4f8 1) Name,  Axis Studio/Axis Neuron & i}
(FIEEAS Avatar 1) hH £E #08 F— > Avatar Name k7K, FATAT LLfE ] Avatar Name
Ja 1HE SR [X 43 AN [] A € ) it

o YJE1% BVH Asset #IRENT Avatar Name 2224k, Actor ZfjiEi2x 4% BVH asset ##f J5IK
)

e  Axis Neuron fll Axis Studio 7 #F&X Avatar name.
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Sensor Map Body Dimension Device Detail Solver Parameter [|Sense:

N Char00

7. ZnBIEH Axis Studio #AF, ZRik Avatar name 4 chr00, fifLAFRAIT# Actor Binding
¥ Avatar Name % E 4 chr00.

4 Actor Binding

Avatar ID
Avatar Name

Oynamic Actor Class

8. il [Play] 47T LA & 241 3h .

3.6 BVH U5 a5 ok 3 £ o

BVH (BiovisionHierarchy) J&—F X, I T4#Mik tH Biovision JF /& iz 34 3R 245
AT LK BVH # K IHHE S-S N UnrealEngine k42 /% BVH %77, {RAELE BVH L)
ISR B AEAEE BVH %, o BVH %W B N Ve N BRI, e iZmak ash
M A A 4ol B A DA K B2 i

1. §A BVH XM, 7£ Axis BfFrh G i e Iy 25k 4% YXZ .

. bvk)

2. fEARENNEET, S Dmport] #2413 N bvh SCfF, 50K bvh STEHES] “ Y283
Wige” mH, oA “ ContentBrowser” THIR K145 4L, %4 Miscellaneous
-> BVH in the right-click.
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s AddiNew'~. X Import Save Al & & | & Content »

[E] YrFilters v [ESEEERIEE

PNSAnim
Blueprint

VERE: A AP AE BVH U177 5 48 S0 w25 F, A sl i i BVH % 7= B a R 9K s)
3. Xk BVH asset T 4nfH a5 &5 A J& Mt ] DLE T 4w 4.

T

C:/Users/admin/Desktop/BYH/Run and Jump.chid0 buh IR

4. ¥ PNSActor #ftF13 5.
[ =e=sss ] (o) W= =98

LIGHTING NEEDS TO BE REBUILT (1 unbuilt object)

M_Body M_Body Dark M_Fac

5. fE World Outliner Tk %5 PNSActor .
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= World Outliner

Search

DirectionalLight
PerceptionNeuronManager
PerceptionNeuranSpawner
Pl

kyLight
phereReflectionCaptur

10 actors (1 selected) @ View Options~

6. EAMVELmEMR kT SkeletalMesh(Inherited) 7% Animation and Mesh J& 1% &
I, W T ERTR:

= World Outliner

8 actors (

[ N PNSActor

+ Add Component

4 efau i nherited)

[ | st (vt

PerceptionMeuron (Inherited)

Search Details jo) E

4 Animation

ion Mode Use Animation Blueprint v

PN_Avatar_Newhodel_v2020_Skeletcr |[fo IR 3

4 Mesh

7. EAMVEANE R ik PercptionNeuron(Inherited).
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Warld Outliner

anieuroniManager
PerceptionMeuronSpawner
PlayersStart

Edit PNSActor

SkyLight
ctionCapture SphereReflectionCaptur

10 actors (1 selected) @ View Op

&) Details

PNSActor

+ Add|Component ~ «; Edit Bluepr

8. fi A Avatar name ¥ BVH SCAFHETEE] BVH asset F{E AL 5+ Actor AR
W, WE R

e Percpionteonirage

SphereReflection
@ View Opt

LN PNSActor

+ Add Component o Edit Bluepri

Search Details fo)

4 Perception Neuron

L LE input character nam from Axis

None -

* 0O

None

o "'?; Run_and_Jump_chroo

drag and drop bvh file to BVH Asset

4 Cooking

Run_and_Jump
_chroo

7¥: BVH Asset J&1%:y— BVH asset 15|/, BVH asset FEEIA M BVH 3hdliEdE ok
B3, MJEM BVH Asset #IR{EIN Avatar ID 2<%k, Actor ZhHE ¥ 1# F] BVH asset HdEiEii4T

UKz,
9. miili [Play] %% 3hHE R
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=B - - mg

Content Marketplace Settings Blueprints Cinematics Resume FrameSkip  Stop Eject

LIGHTING NEEDS TO BE REBUILT (1 unbuilt object)
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1. TRETE

4.1 WA ARERAHLE]
TETHE, FELERE “IRIiAE (Game Default Map)”, ZHEEAETTH
WK IFaa I . R AR ERFERHTATE, XFTEE R SEG2 R4, WRAT v B

H AR A, Biln « 5 —

-

NFR” AR B “ 20 = AFK” AR, TR 20 = A s iz ib K

1. #£ Editor's F:3¢Z#d1 51 Edit > Project Settings > Maps & Modes

Window
1

Help

*7) Undo Clicking on Actors

) Undo History

Light

Ciner

Visug “onf
L.

Ge: on. ”

Volur

Project

Engine

Al System

File f{‘iz Window  Help
Load andSav
A New Level

Search Details

“Project - Maps & Modes

ved in DefaultEngine.ini, which is currently writable.

.4 Default Modes

I - o +

4 Default Maps

¥ " PackageRP
Editor Startun Man =

) ' Seloct the level yBUust savad. 2

¥ ) Packagenp
Game Default Map -
)

.
@ Save Current  Source Control

‘haracter

Connect To Source Control..
g
¥ New Project

W NewC

|2 Package Pro, [z'

Cook Content for Windows
taValidat A
# Validate Data

Android
HoloLens
i0S

Linux

» Lumin

Import Into Level . m

Export All Zip Up Project . 10 Windows | 64-b|t

& Favorite Levels
I Recent Levels
T Recent Projects

¥3| Exit

PREF B — Ak A s H R AEHE . RIT ORI e, W H SR a S TR mmHE .
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5.3Et74E T-pose AL B H & & 7]

WIRARMIRE T AL LS LTS Axis PRI ER 194 —5, HA 2 T-pose, 1RAT
PLid It PR 7775 UES H i e il 20 D sl 1] 8

1, SK_Mannequin_Skeleton [FJJEHEZL A/ A -pose, [H/& Axis Bzl HEIEHE ZRAGH T
-pose MREAY . YFRATTIE 23X P A AN 2 ] 3 9 2 A AN — B ) i FR AT T AT LA — R 5k
FRRAZ ]

1. 7£ Content Browser 15 N\ SK_Mannequin Skeletal Mesh
U

Impo letal Mesh

s [ _oa
FEX Impart Options S|

Reset to Default

Current Asset] /G

4 Mesh

v ]
v ]

Gecmetry and Skinning Weights. »

None

€0

4 Transform
[ Import Translatio
I Import R

Import Unifo

4 Miscellaneous

4 Material

tion

[LECE N G0 Create New Materials =

-

2. Wi SK_Mannequin_Skeleton 3777 8% % 2%

M_UE4Man_ M_UE4Man_

Body ChestLogo

3. 7E Skeleton #miEes+ T HA~ A [Retarget Source Manager] $44l.
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4. g

5.

File

Edit \sset  Window  Help

L

Browse Prey

Anim Nofifies

HIE 0N T-pose (1% i B i i@ e F i 2E A7 ).

BHUE S [Modify Posel #4H

File Edit Window  Help

ek e

and if you have an animation for a big
quy, you can create a Retarget Source from the big guy
and setit for the animation.The Retargeting system will

use this information when extracting animation

(ETE ST E LGSR Add New ) Update All

Set up Rig

leton, then when you
ent skeleton with the

Select ng None

T [ e e ey

Target

Manage Retarget Base Pose

nformation d when retargeting
ent skeleton. You need to make sure the ref
th I hen retargeting, so you can
and edit using the bone transform widget
ve button below.

7. THF i [Create Asset] /A )5iL#f Create Animation >current pose, 1Kl
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File  Edit

Anim
g Anim
Current Skeleton

Search

Re

8. EFEMIFI S S [OK.] J51F Asset Browser F261 7 T

SK_Mannequin_Skeleton_Sequence asset Ji-# 41T JT

Arfinsgzition Blueprint

Som| » e .

Skeleton

Parent Asse

4 Additive Settings

4 Notifies

pone o (TN O D

4 Compression

[hd. |~ RO
Reioetiage: 51.60% CurrentTime: ( cO )) Current Frame: 0
Allow Fram: (2] L WadON PP iem & Vi Ot
9. JF SK_Mannequin skeletal mesh £ %) # K]

% *

M_UE4Man_ M_UE4Man_
Body ChestLogo

SK_Mannequin_ SK_Mannequin_

SK_Mannequin “ppycicsAsset Skeleton

10. XU T Bl 1A
11. AnimGraph H flbs 47 #8612 NewPoseCalc 5 &5 %% Output pose i /.

“Final Animation Pose
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12. Click NewPoseCalc and finish Skeletons retargeting manually.

Details

Skeletons Retargeting

Map

-« I

IS R |~
T T -

ETTE T -
ETTE CTY R -
T T -
I T -
onrocam o~ |
T R— rTE— -

13. ¥ SK_Mannequin_Skeleton_Sequence #if%] Animgraph 3K HiE R
NewPoseCalc 5 /.

File Edit Asset View
ﬂ}- A
Find  Hide Unrelate
1 AnimGraph

eltepfint C

< (B

Play SK_Mannequin_Skeleton_Sequence

connet to NewPoseCalc

+ Add New ~ [EEIE] oo

4Graphs
- * Reference Pose *
4=z EventGraph t t
Event Blueprint Update Animation Name
P P

“Animation Graphs <2 SK_Mannequin_Skeleton_Sequence __/Game | _____|

21 AnimGraph

Animation Layers

Functions
Macros
Variables

Event Dispatchers

© View Options~

14. /A7 [Compile] #1 [Savel .
15. FEHIFEETFH 2% 3.4 ~3.6.
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